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INSTALLATION INSTRUCTIONS

NI SCXI"-1377

Terminal Block for the NI SCXI-1130

CORFaALBCE BERER-JDHEFENTLET,

This guide describes how to install and connect signals to the
National Instruments SCXI-1377 terminal block to configure the
SCXI-1130 as a:

e 256x1, 1-wire multiplexer

e 128x1, 2-wire multiplexer

*  64x1, 4-wire multiplexer

*  Multiplexer or matrix configuration using the Independent topology

Refer to the NI Switches Getting Started Guide to determine when to install
the terminal block.

Introduction

The SCXI-1377 terminal block installs in front of the SCXI-1130 switch
module. The SCXI-1377 uses spring terminals and screw terminals to
connect signals to the switch. Screw terminals for the trigger input and
trigger output signals are also available.

Conventions

The following conventions are used in this guide:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

@ This icon denotes a tip, which alerts you to advisory information.

¢ NATIONAL
’ INSTRUMENTS



bold

italic

monospace

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names and information on hardware labels.

Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.

1. Unpack the Terminal Block

To avoid damage when you handle the terminal block, take the following
precautions:

A Caution Never touch the exposed pins of connectors.

e Ground yourself using a grounding strap or by touching a grounded
object.

*  Touch the antistatic package to a metal part of the chassis before you
remove the terminal block from the package.

Remove the terminal block from the package and inspect the terminal block
for loose components or any sign of damage. Notify NI if the terminal
block appears damaged in any way. Do not install a damaged terminal
block on a switch module.

Store the terminal block in the antistatic package when not in use.

2. Verify the Components

Make sure you have the following:
U NI SCXI-1377 terminal block

U SCXI chassis

NI SCXI-1377 Installation Instructions 2 ni.com
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NI SCXI-1130 switch module
1/8 inch flathead screwdriver
Phillips screwdriver

Wire cutter

Wire insulation stripper

@ Tip NI recommends using 28 AWG wire (ribbon or discrete) for use with the
NI SCXI-1377 terminal block.

3. Connect Signals

To connect signals to the terminal block, refer to Figures 1 and 2 while
completing the following steps:

1.

2.
3.
4

e

Prepare the signal wire by stripping the insulation no more than 7 mm.
Remove the top cover screw.
Unsnap and remove the top cover.

Loosen the two strain-relief screws on the strain-relief assembly and
remove the top strain-relief bar.

Run the signal wires through the strain-relief opening.

Open each terminal by pressing the spring pad with a flathead
screwdriver. Insert the stripped end of the wire fully into the terminal.
Release the spring pad to secure the wire. No bare wire should extend
past the spring terminal. Exposed wire increases the risk of a
short-circuit causing a failure.

@ Note When connecting signals to the NI SCXI-1377, refer to Tables 1, 2, and 3 to
determine where to connect signals for the chosen topology.

7.

© National Instruments Corporation

Replace the strain-relief bar and tighten the two screws on the
strain-relief assembly to secure the cables.

Reinstall the top cover.

Replace the top cover screw.

3 NI SCXI-1377 Installation Instructions



SCXI-1377 Terminal Block

Figure 1.
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Figure 2. SCXI-1377 Terminal Block Signal Connections
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Table 1. 256x1, 1-Wire Multiplexer Topology Mapping

Software | Hardware Software | Hardware Software | Hardware Software | Hardware
com0 OUT 0 ch64 CH 64 ch128 CH 128 ch192 CH 192
ch0 CH 00 ch65 CH 65 ch129 CH 129 ch193 CH 193
chl CH 01 ch66 CH 66 ch130 CH 130 ch194 CH 194
ch2 CH 02 ch67 CH 67 ch131 CH 131 ch195 CH 195
ch3 CH 03 ch68 CH 68 ch132 CH 132 ch196 CH 196
ch4 CH 04 ch69 CH 69 ch133 CH 133 ch197 CH 197
ch5 CH 05 ch70 CH 70 ch134 CH 134 ch198 CH 198
ch6 CH 06 ch71 CH71 ch135 CH 135 ch199 CH 199
ch7 CH 07 ch72 CH 72 ch136 CH 136 ch200 CH 200
ch8 CH 08 ch73 CH73 ch137 CH 137 ch201 CH 201
ch9 CH 09 ch74 CH 74 ch138 CH 138 ch202 CH 202
chl10 CH 10 ch75 CH75 ch139 CH 139 ch203 CH 203
chll CH 11 ch76 CH 76 ch140 CH 140 ch204 CH 204
ch12 CH 12 ch77 CH 77 ch141 CH 141 ch205 CH 205
chl3 CH 13 ch78 CH 78 ch142 CH 142 ch206 CH 206
chl4 CH 14 ch79 CH 79 ch143 CH 143 ch207 CH 207
chl5 CH 15 ch80 CH 80 ch144 CH 144 ch208 CH 208
chl16 CH 16 ch81 CH 81 ch145 CH 145 ch209 CH 209
chl17 CH 17 ch82 CH 82 ch146 CH 146 ch210 CH 210
chl8 CH 18 ch83 CH 83 ch147 CH 147 ch211 CH 211
ch19 CH 19 ch84 CH 84 ch148 CH 1438 ch212 CH 212
ch20 CH 20 ch85 CH 85 ch149 CH 149 ch213 CH 213
ch21 CH 21 ch86 CH 86 ch150 CH 150 ch214 CH 214
ch22 CH 22 ch87 CH 87 ch151 CH 151 ch215 CH 215
ch23 CH 23 ch88 CH 88 chl152 CH 152 ch216 CH 216
ch24 CH 24 ch89 CH 89 ch153 CH 153 ch217 CH 217
ch25 CH 25 ch90 CH 90 ch154 CH 154 ch218 CH 218
ch26 CH 26 ch91l CHO1 ch155 CH 155 ch219 CH 219
ch27 CH 27 ch92 CH 92 ch156 CH 156 ch220 CH 220
ch28 CH 28 ch93 CH 93 ch157 CH 157 ch221 CH 221
ch29 CH 29 ch%4 CH % ch158 CH 158 ch222 CH 222
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Table 1. 256x1, 1-Wire Multiplexer Topology Mapping (Continued)

Software | Hardware Software Hardware Software Hardware Software | Hardware
ch30 CH 30 ch95 CH 95 ch159 CH 159 ch223 CH 223
ch31 CH 31 ch96 CH 96 ch160 CH 160 ch224 CH 224
ch32 CH 32 ch97 CH 97 chl6l CH 161 ch225 CH 225
ch33 CH 33 ch98 CH 98 ch162 CH 162 ch226 CH 226
ch34 CH 34 ch99 CH 99 ch163 CH 163 ch227 CH 227
ch35 CH 35 ch100 CH 100 chl64 CH 164 ch228 CH 228
ch36 CH 36 ch101 CH 101 ch165 CH 165 ch229 CH 229
ch37 CH 37 ch102 CH 102 ch166 CH 166 ch230 CH 230
ch38 CH 38 ch103 CH 103 ch167 CH 167 ch231 CH 231
ch39 CH 39 ch104 CH 104 ch168 CH 168 ch232 CH 232
ch40 CH 40 ch105 CH 105 ch169 CH 169 ch233 CH 233
ch41 CH 41 ch106 CH 106 ch170 CH 170 ch234 CH 234
ch42 CH 42 ch107 CH 107 chl71 CH 171 ch235 CH 235
ch43 CH 43 ch108 CH 108 ch172 CH 172 ch236 CH 236
ch44 CH 44 ch109 CH 109 ch173 CH 173 ch237 CH 237
ch4s CH 45 ch110 CH 110 ch174 CH 174 ch238 CH 238
ch46 CH 46 chlll CH 111 chl75 CH 175 ch239 CH 239
ch47 CH 47 chl12 CH 112 chl76 CH 176 ch240 CH 240
ch48 CH 48 chl13 CH 113 chl77 CH 177 ch241 CH 241
ch49 CH 49 chl14 CH 114 ch178 CH 178 ch242 CH 242
ch50 CH 50 chl15 CH 115 ch179 CH 179 ch243 CH 243
ch51 CH 51 chl16 CH 116 ch180 CH 180 ch244 CH 244
ch52 CH 52 chl17 CH 117 chl181 CH 181 ch245 CH 245
ch53 CH 53 chll18 CH 118 ch182 CH 182 ch246 CH 246
ch54 CH 54 chl19 CH 119 ch183 CH 183 ch247 CH 247
ch55 CH 55 ch120 CH 120 ch184 CH 184 ch248 CH 248
ch56 CH 56 ch121 CH 121 ch185 CH 185 ch249 CH 249
ch57 CH 57 ch122 CH 122 ch186 CH 186 ch250 CH 250
ch58 CH 58 ch123 CH 123 ch187 CH 187 ch251 CH 251
ch59 CH 59 chl124 CH 124 ch188 CH 188 ch252 CH 252
ch60 CH 60 ch125 CH 125 ch189 CH 189 ch253 CH 253
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Table 1. 256x1, 1-Wire Multiplexer Topology Mapping (Continued)

Software | Hardware Software Hardware Software Hardware Software | Hardware
ch61 CH 61 ch126 CH 126 ch190 CH 190 ch254 CH 254
ch62 CH 62 ch127 CH 127 ch191 CH 191 ch255 CH 255
ch63 CH 63

Table 2. 128x1, 2-Wire Multiplexer Topology Mapping
Hardware Hardware Hardware

Software + - Software + - Software + -
comO OouT 0 OUT 1 ch42 CH 74 CH 90 ch8s CH 165 | CH 181
ch0 CH 00 CH 16 ch43 CH 75 CH 91 ch86 CH 166 | CH 182
chl CH 01 CH 17 ch44 CH 76 CH 92 ch87 CH 167 | CH 183
ch2 CH 02 CH 18 ch45 CH 77 CH 93 ch88 CH 168 | CH 184
ch3 CH 03 CH 19 ch46 CH 78 CH %4 ch89 CH 169 | CH 185
ch4 CH 04 CH 20 ch47 CH 79 CH 95 ch90 CH 170 | CH 186
ch5 CH 05 CH 21 ch48 CH 96 CH 112 ch91 CH 171 | CH 187
ch6 CH 06 CH 22 ch49 CH 97 CH 113 ch92 CH 172 | CH 188
ch7 CH 07 CH 23 ch50 CH 98 CH 114 ch93 CH 173 | CH 189
ch8 CH 08 CH 24 ch51 CH 99 CH 115 ch94 CH 174 | CH 190

ch9 CH 09 CH 25 ch52 CH 100 | CHI116 ch95 CH 175 | CH 191
ch10 CH 10 CH 26 ch53 CH 101 CH 117 ch96 CH 192 | CH208
chll CH 11 CH 27 ch54 CH102 | CHI118 ch97 CH 193 | CH 209
chl2 CH 12 CH 28 ch55 CH 103 CH 119 ch98 CH 194 | CH210
ch13 CH 13 CH 29 ch56 CH 104 | CH 120 ch99 CH 195 | CH211
chl4 CH 14 CH 30 ch57 CH 105 CH 121 ch100 CH 196 | CH212
chl5 CH 15 CH 31 ch58 CH 106 | CH 122 ch101 CH 197 | CH213
chl6 CH 32 CH 48 ch59 CH 107 CH 123 ch102 CH 198 | CH214
ch17 CH 33 CH 49 ch60 CH 108 CH 124 ch103 CH 199 | CH215
ch18 CH 34 CH 50 ch61 CH109 | CH125 ch104 CH200 | CH216
ch19 CH 35 CH 51 ch62 CH 110 | CH 126 ch105 CH201 | CH217
ch20 CH 36 CH 52 ch63 CH 111 CH 127 ch106 CH202 | CH218
ch21 CH 37 CH 53 ch64 CH 128 CH 144 ch107 CH203 | CH219
ch22 CH 38 CH 54 ch65 CH 129 | CH 145 ch108 CH204 | CH?220
ch23 CH 39 CH 55 ch66 CH 130 | CH 146 ch109 CH205 | CH221
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Table 2. 128x1, 2-Wire Multiplexer Topology Mapping (Continued)

Hardware Hardware Hardware
Software + - Software + - Software + -
ch24 CH 40 CH 56 ch67 CH 131 | CH 147 ch110 CH206 | CH222
ch25 CH 41 CH 57 ch68 CH132 | CH 148 chlll CH207 | CH223
ch26 CH 42 CH 58 ch69 CH 133 | CH 149 chl12 CH 224 | CH240
ch27 CH 43 CH 59 ch70 CH 134 CH 150 chl13 CH 225 CH 241
ch28 CH 44 CH 60 ch71 CH 135 CH 151 chl14 CH 226 | CH?242
ch29 CH 45 CH 61 ch72 CH 136 | CH152 chl15 CH 227 | CH?243
ch30 CH 46 CH 62 ch73 CH 137 | CH153 ch116 CH 228 | CH244
ch31 CH 47 CH 63 ch74 CH 138 | CH154 ch117 CH 229 | CH245
ch32 CH 64 CH 80 ch75 CH139 | CHI155 chl18 CH 230 | CH246
ch33 CH 65 CH 81 ch76 CH 140 | CH 156 ch119 CH 231 | CH 247
ch34 CH 66 CH 82 ch77 CH 141 CH 157 ch120 CH 232 | CH?248
ch35 CH 67 CH 83 ch78 CH 142 | CH 158 chl21 CH 233 | CH249
ch36 CH 68 CH 84 ch79 CH 143 | CH 159 ch122 CH 234 | CH250
ch37 CH 69 CH 85 ch80 CH160 | CH176 ch123 CH 235 | CH251
ch38 CH 70 CH 86 ch81 CH 161 | CH177 ch124 CH 236 | CH252
ch39 CH71 CH 87 ch82 CH162 | CH178 ch125 CH 237 | CH253
ch40 CH72 CH 88 ch83 CH163 | CH179 ch126 CH 238 | CH254
ch41 CH 73 CH 89 chg4 CH 164 | CH 180 ch127 CH 239 | CH255
Table 3. 64x1, 4-Wire Multiplexer Topology Mapping
Hardware Hardware
Software A+ A- B+ B- Software A+ A- B+ B-
com0 OUT 0 OUT 1 OUT 4 OUT 5 ch32 CH128 | CH144 | CH192 | CH208
ch0 CH 00 CH 16 CH 64 CH 80 ch33 CH129 | CH145 | CH193 | CH209
chl CHO01 CH 17 CH 65 CH 81 ch34 CH130 | CH146 | CH194 | CH210
ch2 CHO02 CH 18 CH 66 CH 82 ch35 CH131 | CH147 | CH195 | CH211
ch3 CH 03 CH 19 CH 67 CH 83 ch36 CH132 | CH148 | CH196 | CH212
ch4 CH 04 CH 20 CH 68 CH 84 ch37 CH133 | CH149 | CH197 | CH213
ch5 CH 05 CH 21 CH 69 CH 85 ch38 CH134 | CHI150 | CH198 | CH214
ch6 CH 06 CH 22 CH 70 CH 86 ch39 CH135 | CH151 | CH199 | CH215
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Table 3. 64x1, 4-Wire Multiplexer Topology Mapping (Continued)

Hardware Hardware
Software A+ A- B+ B- Software A+ A- B+ B-
ch7 CH 07 CH 23 CH71 CH 87 ch40 CH136 | CH152 | CH200 | CH216
ch8 CH 08 CH 24 CH 72 CH 88 ch41 CH 137 | CHI153 | CH201 | CH217
ch9 CH 09 CH 25 CH 73 CH 89 ch42 CH 138 | CH154 | CH202 | CH218
ch10 CH 10 CH 26 CH 74 CH 90 ch43 CH139 | CH155 | CH203 | CH219
chll CH 11 CH 27 CH 75 CH91 ch44 CH 140 | CH156 | CH204 | CH?220
chl2 CH 12 CH 28 CH 76 CH 92 ch45 CH 141 | CH157 | CH205 | CH?221
ch13 CH 13 CH 29 CH 77 CH 93 ch46 CH 142 | CHI158 | CH206 | CH?222
chl4 CH 14 CH 30 CH 78 CH 94 ch47 CH 143 | CHI159 | CH207 | CH?223
chl5 CH 15 CH 31 CH 79 CH 95 ch48 CH 160 | CH176 | CH224 | CH 240
chl6 CH 32 CH 48 CH 96 CH 112 ch49 CH 161 CH 177 | CH225 | CH?241
chl7 CH 33 CH 49 CH 97 CH 113 ch50 CH162 | CH178 | CH226 | CH?242
ch18 CH 34 CH 50 CH 98 CH 114 ch51 CH163 | CH179 | CH227 | CH243
ch19 CH 35 CH 51 CH 99 CH 115 ch52 CH164 | CH180 | CH228 | CH244
ch20 CH 36 CH 52 CH 100 | CH 116 ch53 CH165 | CHI181 | CH229 | CH245
ch21 CH 37 CH 53 CH 101 | CH 117 ch54 CH 166 | CH182 | CH230 | CH?246
ch22 CH 38 CH 54 CH102 | CH118 ch55 CH167 | CH183 | CH231 | CH247
ch23 CH 39 CH 55 CH 103 | CH119 ch56 CH168 | CH184 | CH232 | CH?248
ch24 CH 40 CH 56 CH 104 | CH 120 ch57 CH169 | CH185 | CH233 | CH?249
ch25 CH 41 CH 57 CH 105 | CH 121 ch58 CH170 | CH186 | CH234 | CH250
ch26 CH 42 CH 58 CH 106 | CH 122 ch59 CH171 | CH187 | CH235 | CH251
ch27 CH 43 CH 59 CH 107 | CH 123 ch60 CH172 | CH188 | CH236 | CH252
ch28 CH 44 CH 60 CH 108 | CH 124 ch61 CH173 | CH189 | CH237 | CH253
ch29 CH 45 CH 61 CH 109 | CH 125 ch62 CH 174 | CH190 | CH238 | CH254
ch30 CH 46 CH 62 CH 110 | CH 126 ch63 CH175 | CH191 | CH239 | CH255
ch31 CH 47 CH 63 CH111 | CH 127
NI SCX1-1377 Installation Instructions 10 ni.com



4. Install the Terminal Block

To connect the SCXI-1377 terminal block to the SCXI-1130 front panel,
refer to Figure 3 and complete the following steps (the SCXI-1130 should
already be installed in an SCXI chassis):

1. Plug the SCXI-1377 onto the front connectors of the SCXI-1130.

2. Tighten the top and bottom thumbscrews on the back of the terminal
block rear panel to hold it securely in place.

S

1 Thumbscrew 3 SCXI-1130
2 Front Connectors 4 SCXI-1377

Figure 3. Installing the SCXI-1377 Terminal Block
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Compliance and Certifications

Safety

This product is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control,
and laboratory use:

« IEC61010-1, EN 61010-1
« UL3111-1, UL 61010B-1
« CAN/CSA C22.2 No. 1010.1

@ Note For UL and other safety certifications, refer to the product label, or visit
ni.com/certification, search by model number or product line, and click the
appropriate link in the Certification column.

Electromagnetic Compatibility

EmiSSions......c...ceeeeviivvieeeeeiiieeeeeeiiveeeeeenns EN 55011 Class A at 10 m
FCC Part 15A above 1 GHz

IMmMUNity .oooeeveieeeieeeee e EN 61326:1997 + A2:2001,
Table 1

EMC/EMI ...coooovviiiiiiiiiiiiiiieieeeeeen CE, C-Tick, and FCC Part 15
(Class A) Compliant

@ Note For EMC compliance, you must operate this device with shielded cabling.

CE Compliance

This product meets the essential requirements of applicable European
Directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety).............. 73/23/EEC

Electromagnetic Compatibility
Directive (EMOC) ...cc.coevvevecenininencnennee 89/336/EEC

@ Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit
ni.com/certification, search by model number or product line, and click the
appropriate link in the Certification column.

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section on
ni.com/legal for more information about National Instruments trademarks. Other product and company names mentioned herein are
trademarks or trade names of their respective companies. For patents covering National Instruments products, refer to the appropriate location:
Help»Patents in your software, the patents. txt file on your CD, or ni . com/patents.

© 2003-2007 National Instruments Corporation. All rights reserved. 373689B Nov07
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